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About PrintSmith Vision 
PrintSmith™ Vision is a browser-based print management system for commercial printers, trade printers, copy 
shops, and quick printers. To help you run your business efficiently and profitably, PrintSmith Vision combines 
estimating, invoicing, billing, point of sale, and accounts receivable in a single product. 

How to Use This Guide 

If you are new to PrintSmith Vision (never used PrintSmith Classic 8.1) 
Task See 

• Make sure you meet technical requirements Page 10 

• Install PrintSmith Vision, including i-net Designer (required if 
you want to add your logo to invoices or customize reports) 

Page 16 

• Understand how to start PrintSmith Vision Page 40 

• Activate your license Page 43 

• Log into PrintSmith Vision Page 49 

• Understand how to stop and start the PrintSmith Vision server Page 49 

• Set up and start using PrintSmith Vision PrintSmith Vision - User and Setup Guide 

If you are upgrading from PrintSmith Classic 8.1 to PrintSmith Vision 
For the procedure for upgrading to PrintSmith Vision from PrintSmith Classic 8.1, including exporting/importing 
your data, see the instructions that begin on page 51. 

Important After you complete the procedures in this manual, see the PrintSmith Vision - User and Setup 
Guide for information about setting up and using the system. 

If you are updating PrintSmith Vision with a more recent version 
For the procedure for updating PrintSmith Vision if you were using an earlier version of it, see the instructions 
that begin on page 35. 

If you upgrade your server hardware 
If you were already using PrintSmith Vision and then decide to upgrade your server hardware, see the 
instructions on page 63. 

PrintSmith Vision Support and Services 
When you purchase PrintSmith Vision, EFI provides several types of support and assistance.  

• Customer Support 

• Documentation 

• Training 

• Maintenance agreements and e-mail forums 
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Customer Support 
You can contact PrintSmith Customer Support in any of the following ways.  

EFI Customer Care Site 

https://customer.efi.com/support 

Use the EFI Customer Care site to report issues, as well as to track the status of issues you reported. 

Important You need a user name and password to log into the EFI Customer Care site. Please 
contact your Customer Support representative to have an account created for you. 

Phone 

North America 

888.731.2618 
480.538.5800 
Monday - Friday 7 A.M. - 5 P.M. US Mountain Standard Time 

UK 

0800 783 2737 
Monday - Friday 8 A.M. - 5 P.M. UK Time 

EMEA 

+49 2102 745 4500 
Monday - Friday 9 A.M. - 6 P.M. Central European Time 

Fax 

480.538.5804 (North America) 

E-Mail 

printsmith.support@efi.com 

Documentation 
You can download documentation (in the form of PDF files) from the PrintSmith Web site.  

For information about See 

Setting up and using PrintSmith Vision PrintSmith Vision - Setup and User Guide 

Configuring receipt printers PrintSmith Vision - Configuring Receipt Printers  

Fiery® integration PrintSmith Vision - Fiery Integration Guide 
Integrated credit card processing in 
PrintSmith Vision 

PrintSmith Vision - Secure Credit Card Processing  

Using Tracker for shop floor data collection PrintSmith Vision - Tracker User Guide 

Using Scheduler PrintSmith Vision - Scheduler User Guide 

Using PrintSmith Site  PrintSmith Vision - PrintSmith Site Integration Guide 
Using Digital StoreFront with PrintSmith 
Vision 

PrintSmith Vision - Digital StoreFront Integration Guide 

Using Four51 OrderCloud™ with PrintSmith 
Vision 

PrintSmith Vision - Four51 Integration Guide 

Using SugarCRM® with PrintSmith Vision PrintSmith Vision - SugarCRM Integration Guide 

Training 
Onsite and remote training sessions of varying durations are available to meet your needs.  

For information about training, in the US, call 480.538.5800; in the UK, call 44.0.1.753.622606.  

https://customer.efi.com/support
mailto:printsmith.support@efi.com
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E-mail forums 
With your maintenance agreement, you can join the PrintSmith e-mail forum to be automatically notified when an 
update is available or to exchange questions and ideas with other users. If your maintenance agreement is 
current, you can manage your subscription to the list at www.printsmith.com. Access to this site requires a user 
name and password. 
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Overview 
The computer where PrintSmith Vision and its database are installed is known as the server. PrintSmith Vision is 
then accessed by users through a browser on Windows® or Macintosh® computers. These computers are also 
known as clients. 

This section describes the technical requirements you must meet for the PrintSmith Vision server (see below) 
and for the client computers (see page 11). In addition, to run PrintSmith Vision, you must meet some 
miscellaneous requirements such as browser version and monitor size and resolution. 

Starting with PrintSmith Vision 3.0, mobile views of parts of the PrintSmith system are available from 
smartphones and tablets. Requirements for taking advantage of mobile views are on page 12. 

Important Below are the system requirements for running PrintSmith Vision based on what was certified by EFI. 
If your environment is not listed below, then it has not been certified, and EFI cannot guarantee or 
support the results. 

PrintSmith Vision Server Requirements 
You can install PrintSmith Vision on a Windows or Macintosh computer as long as it meets the requirements 
listed below.  

Important Although you can run PrintSmith Vision on a shared server, EFI strongly recommends a dedicated 
server. Not only does performance degrade when several applications run on the server, but 
issues resulting from conflicting applications can be very difficult to diagnose. This type of 
diagnosis is therefore not supported by EFI. 

  PrintSmith Vision can run on a virtual machine (VM). While EFI supports PrintSmith Vision running 
in a virtual environment, EFI is not responsible for your virtual environment or its setup. EFI will use 
commercially reasonable efforts to investigate potential issues with PrintSmith Vision running on a 
virtual machine, but as part of that investigation, EFI may require the issue to be reproduced 
independently of the virtual machine environment. When issues are confirmed to be unrelated to 
the virtual environment, EFI will support PrintSmith Vision in a way that is consistent with the 
support provided when PrintSmith Vision is running in a non-virtual environment.  

Windows 64-bit 
Operating system: Windows 7 (existing installations only, not new installations) 

Windows 8 
Windows 10 *  
Windows Server 2008 R2 Standard (existing installations only, not new installations) 
Windows Server 2012 R2 Standard or Essentials **  

Processor: Intel Quad Core i7 2.3 GHz 
Memory: 16 GB (more memory will improve performance) 

Hard drive: 50 GB free space 

Important * If you currently use PrintSmith Vision and want to upgrade to Windows 10, be sure to follow the 
instructions in “If you plan to upgrade to Windows 10” on page 36 to avoid losing your installation. 

  ** If you use Internet Explorer 11 on Windows Server 2012, some additional configuration may be 
required. See page 41. 

  As of PrintSmith Vision 3.2, Windows Server 2008 and Windows 7 are supported only for existing 
installations, not new installations of PrintSmith Vision.  
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Macintosh 
Operating system: OS X version 10.9, 10.9 Server, 10.10, 10.10 Server, 10.11*, or 10.11 Server*  

Processor: Intel Quad Core i7 2.3 GHz 
Memory: 16 GB (more memory will improve performance) 

Hard drive: 50 GB free space 

Important  New Macs (10.9 and higher) do not have Java installed, which is required to install PrintSmith 
Vision. Download and install Java (version 7) before starting the PrintSmith Vision Installer. 

  * If you currently use PrintSmith Vision and want to upgrade to OS X 10.11 (El Capitan), be sure to 
follow the instructions in “If you plan to upgrade to Macintosh OS X 10.11 (El Capitan)” on page 36. 

Important Notes About the Server 
• If PrintSmith Vision is going to be run from other computers (clients), the server computer should have a 

static IP address. This IP address is part of the URL users enter to run PrintSmith Vision; if the IP 
address keeps changing (because it is not static), the URL will also keep changing. 

• In addition, the server computer must be configured not to go to sleep. If the server goes to sleep, users 
who are running PrintSmith Vision from other computers will get a “server down” message, and will be 
unable to use PrintSmith while the server is in sleep mode. On a Windows computer, turn off sleep 
mode in the Power Options settings in the Control Panel; on a Macintosh, turn off sleep mode in the 
Energy Saver settings. 

PrintSmith Vision Client Requirements 
The requirements for running PrintSmith Vision on a client computer (one on which PrintSmith Vision is not 
installed) are: 

Operating system: Windows 7, 8, or 10 
Macintosh OS X 10.8 or higher 

Memory: 4 GB minimum (more memory will improve performance) 
Browser: See “Browser Requirements” below 
Monitor: See “Monitor and Resolution Requirements” on page 12 

Browser Requirements 
The following browsers are supported for using PrintSmith Vision: 

• Internet Explorer 10 or 11 

Note When using Internet 11 with Windows Server 2012 R2 Standard or Essentials, some additional 
configuration may be required. See page 41. 

• Mozilla Firefox® 40.x or later  

Note Do not use Firefox 37 or 38 on a Macintosh; a known issue prevents users from entering their 
PrintSmith Vision user name and password with this version of Firefox. 

• Safari® 7.x or later 

• Chrome™ 41 or later 
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Monitor and Resolution Requirements 
PrintSmith Vision is designed to be viewed and used on a large monitor with high resolution: 

• 19-inch monitor 

• Minimum resolution of 1280 x 1024  

Important If you are using a laptop, to see estimates and invoices in full, the height (second number) 
must be at least 1024 pixels.  

Network Requirements 
• 100 base T Ethernet 

Internet Requirements 
In addition to being required to run PrintSmith Vision, Internet connectivity is required as follows: 

• For initial licenses of software 

• For upgrades and upgrade licenses 

• For Payment Plan users during defined periods of plan 

• For interaction with EFI Support team 

Custom Document and Report Requirements 
PrintSmith Vision reports and other documents (such as estimates or invoices) are written in i-net Clear Reports. 

If you want to customize your estimates or invoices (for example, include your logo) or if you plan to create 
custom reports, you must install i-net Designer, which is part of Clear Reports. You will be given the option to 
install i-net Designer during the PrintSmith Vision server installation. 

Receipt Printer Requirements 
A receipt printer is optional in PrintSmith Vision, but if you want to use one, you must purchase the Star TSP 
700ll printer from EFI.  

For important information about configuring the receipt printer, see the PrintSmith Vision - Configuring Receipt 
Printers. 

Fiery Integrations  
If you are using PrintSmith Vision with a Fiery®, Fiery JDF version 1.3.0.22 is required. 

Digital StoreFront Integrations 
If you are using PrintSmith Vision with Digital StoreFront®, Digital StoreFront 8.4 or higher is required to take 
advantage of the two-way integration introduced in PrintSmith Vision 3.0. 

Mobile View Requirements 
As of PrintSmith Vision 3.0, mobile views of parts of the PrintSmith system are available from smartphones and 
tablets. Mobile views are based on HTML5 technology. This section describes devices, operating systems, and 
browsers that are fully compatible with HTML5 and can therefore support PrintSmith Vision mobile views. 

Mobile devices 
The following mobile devices are supported: 

• iPad® 4th and 5th generation 
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• iPhone® 5 and 6 

• Android™ tablets 

• Android smartphones  

Mobile operating systems 
• iOS 8.3 

• Android 4.1, 5.1 

Browser requirements for mobile views 
The following browsers are supported: 

• Chrome 21 or higher 

• Safari 5 or higher 

Note Mozilla Firefox is not supported. 
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Before You Begin 
1. Make sure the computer on which you plan to install the PrintSmith Vision server meets the system 

requirements described in “PrintSmith Vision Server Requirements” on page 10. Also make sure you 
have your license (you will not be able to run PrintSmith Vision until you provide your license 
information).  

To obtain your license, contact PrintSmith.Sales@efi.com. 

2. Obtain instructions from your EFI representative about downloading the installer (PrintSmith Vision 
Server Installer). 

3. Decide whether you need to use an SSL (https://) connection because that requires the purchase and 
installation of an SSL certificate. See “Using an SSL Connection” below. 

4. Make sure you are logged in as an administrator on the server computer, or you will be unable to install 
the software. 

5. Close any applications that are running on the computer and be prepared for a re-start after installation 
is complete. 

6. While installing the PrintSmith Vision Server, you will have the option of installing i-net Designer. If you 
want to customize your estimates or invoices (for example, include your logo), or if you plan to create 
custom reports, be sure to install i-net Designer, which is part of Clear Reports. PrintSmith reports and 
other documents (such as estimates and invoices) were created in Clear Reports. 

The sections that follow describe the installation process on a Windows and Macintosh computer. (The process 
is very similar.) 

Important If you are upgrading from PrintSmith 8.1 to PrintSmith Vision, the installation of PrintSmith Vision is 
just one part of the upgrade process. See “Upgrade Checklist” on page 52. 

  If you already have PrintSmith Vision installed and are applying an update, see “If You Are 
Updating PrintSmith Vision” on page 35. The instructions in this chapter are for new installations. 

Using an SSL Connection 
As of version 2.3, PrintSmith Vision includes support for SSL (Secure Sockets Layer). SSL creates an encrypted 
connection between the PrintSmith Vision server and your users’ browser, preventing eavesdropping and data 
tampering. When you use SSL, the URL to your server is prefaced by https:// instead of http://.  

Note To use SSL, you must purchase an SSL certificate from a certificate authority (CA) and then install and 
configure it (with the help of EFI Support). The certificate must be compatible with Apache Tomcat 
version 7. 

A non-SSL connection (which is the default connection between PrintSmith Vision and users’ browsers) is not 
encrypted. This means data transmitted to and from the server could in theory be seen by others. 

Important! Even if you use non-SSL, credit card information is never at risk. This information is never stored in 
PrintSmith Vision,  and USA ePay ensures the security of the transmission of credit card 
information.  

  If you are unfamiliar with SSL and SSL certificates, EFI strongly recommends you use the default 
non-SSL connection. 

  Some organizations may have policies requiring SSL for all data exchange over the Internet, in 
which case they can take advantage of this new SSL functionality in PrintSmith Vision. 

During the installation process, you will be given the choice of using a non-SSL or SSL connection. Non-SSL is 
the default. 

  

mailto:PrintSmith.Sales@efi.com
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If Installing the PrintSmith Vision Server on a Windows Computer 
Notes EFI recommends that you close all applications on your computer before starting the installation. 
 To complete installation, you will need to re-start the computer. 
 If you are installing on Windows Server 2012 R2 Standard or Essentials, and plan to use Internet 

Explorer 11, see page 41 for some additional configuration steps you may need to complete.  
1. After you obtain the installer, double-click PSV Installer.exe. 

2. The installer defaults to the language of your operating system, but you can change it if necessary. 
Either leave the selected language or select a different language and click OK.  

 
3. Review the reminders and instructions in the Introduction window and click Next to continue. 
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4. Read the license agreement, click I accept…, and then click Next to continue. 

 
5. Decide if you want to use a Non SSL or SSL connection (Non SSL is the default) and click Next. For 

information about using SSL (which requires the purchase and installation of an SSL certificate), see 
page 16. 

Note If you select SSL, with the help of EFI Support, you must install and configure your SSL 
certificate after PrintSmith Vision is installed. See page 33. 
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6. Accept the proposed location (C:\Program Files (x86)\EFI\PrintSmith) or click Choose and select a 
folder. (If you select a different folder but change your mind, you can click Restore Default Folder.) 
Then click Next. 

 
7. Select one of the following in the Select a starting point window and then click Next: 

• If you are upgrading from PrintSmith to PrintSmith Vision (and therefore importing your data), select 
UPGRADE. In an upgrade, an empty database is created so you can import your data into the 
database. 

Note After the PrintSmith Vision server is installed, follow the instructions for exporting and 
importing your data in “Upgrading from PrintSmith Classic to PrintSmith Vision” on page 
51. 

• If you are new to PrintSmith Vision (and have no data to import), select NEW USER. In a new 
installation, the database includes sample pricing information to help you get started using 
PrintSmith Vision. 
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8. By default, PrintSmith Vision uses port 9191 for non-SSL communication and port 8443 for SSL 
communication. Depending on whether you selected Non SSL or SSL in step 5, the Installer checks 
whether the appropriate port is available.  

• If port 9191 (for non-SSL) or port 8443 (for SSL) is available, installation proceeds. Go to step 9. 

• If port 9191 (for non-SSL) or port 8443 (for SSL) is being used by another application, another port 
number is suggested. Either accept the suggested port number or enter a different unused port 
number. (If you enter an invalid port number or a number that is being used, you will be asked 
again for a port number.) 

Note The port number is part of the URL used to start PrintSmith Vision so if you are not using a 
default port number (9191 for non-SSL or 8443 for SSL) you will need to specify your port 
number as part of the URL. For more information about the URL used to start PrintSmith 
Vision, see “PrintSmith Vision URL” on page 40. 

The installer now checks your system and installs any components that are required by PrintSmith 
Vision but that are not installed on your computer (for example, Java Run Time).  

9. If you get the following security warning, click Allow access. 
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10. If the Default Language Selection window opens, select your language.  

Important The language you select here affects locale settings such as the thousands and decimal 
separators and the currency used in PrintSmith Vision. 

 
11. Review what is being installed. If you want to change anything (like the install folder), click Previous 

and make your corrections. Otherwise, click Install. 

 
12. When a cmd window like the following opens, ignore it. No action is required on your part. 
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13. When asked if you want to install i-net Designer, click Yes if you plan to add your logo to documents, 
customize the job ticket, or create custom reports. (You need i-net Designer to customize documents 
and reports.) 

Note EFI recommends that you install i-net Designer now, but you can always do so later by running 
Setup.bar in the \Program Files (x86)\EFI\PrintSmith\Crystal_Clear_Installer folder.   

 
14. If you clicked Yes in the previous step, complete the installation steps for i-net Designer: 

a. Click Designer. 

 
b. Read and accept the license agreement and then click Next. 
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c. Accept the proposed installation folder (or specify a different folder) and click Next. 

 
d. By default, shortcuts are created for you. Click Next to continue. 
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e. Review what is being installed. If you want to change anything (like the install folder), click 
Previous and make your corrections. Otherwise, click Install. 

 
f. After the installation is complete, click Done. An i-net Designer shortcut is now available on your 

desktop. 
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15. The installation of the PrintSmith Vision server now continues. When asked if you want PrintSmith 
Vision to start automatically when you start the computer, click Yes or No.  

Note EFI recommends that you click Yes (the default). Otherwise, each time you shut down the 
server computer, you must start the server manually. 

 
16. When the Install Complete window opens, click Done to exit the installer and re-start the computer. 

Then click OK to confirm the re-start. 

 
Notes If you clicked Yes (as recommended) in step 15, the PrintSmith Server will now be running as a service 

in the background. If you clicked No in step 15, start the server as explained in “Starting and Stopping 
the PrintSmith Vision Server” on page 49. 

 If you installed PrintSmith Vision on Windows Server 2012 R2 Standard or Essentials, and plan to use 
Internet Explorer 11, see page 41 for some additional configuration steps you may need to complete. 

 

 

 

 

  



26  EFI PrintSmith Vision | Installation and Upgrade Guide 

 
 

 

If Installing the PrintSmith Vision Server on a Macintosh Computer 
Starting with OS X 10.9, Apple does not install Java on Macs. Java is required to run the PrintSmith Vision 
Installer, so you must download and install Java before starting the installation process. (The Installer will warn 
you if Java is not installed.) 

Notes EFI recommends that you close all the applications on your computer before starting the installation 
process. 

 To complete installation, you will need to re-start the computer.  
1. After you obtain the installer, double-click PSV Installer.  

2. In the Authentication window, click the lock to make changes (you need to provide an administrator 
password.) 

 
3. The default language is English. If necessary select a different language and click OK.  

4. In the Introduction window, review the reminders and instructions and click Next to continue.  
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5. Read the license agreement, click I accept…, and then click Next to continue. 

 
6. Decide if you want to use a Non SSL or SSL connection (Non SSL is the default) and click Next. For 

information about using SSL (which requires the purchase and installation of an SSL certificate), see 
page 16. 

Note If you select SSL, you must install and configure your SSL certificate after PrintSmith Vision is 
installed. For details, see  page 33. 
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7. In the Choose Install Folder window, accept the proposed location (/Applications/EFI/PrintSmith) and 
click Next. 

Important! A custom installation folder is currently not supported; use the default folder instead. 

 
8. In the Select a starting point window, choose one of the following and then click Next: 

• If you are upgrading from PrintSmith to PrintSmith Vision (and therefore importing your data), select 
UPGRADE. In an upgrade, an empty database is created so you can import your data into the 
database. 

Note After the PrintSmith Vision server is installed, follow the instructions for exporting and 
importing your data in “Upgrading from PrintSmith Classic to PrintSmith Vision” on page 
51. 

• If you are new to PrintSmith Vision (and have no data to import), select NEW USER. In a new 
installation, the database includes sample pricing information to help you get started using 
PrintSmith Vision. 
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9. By default, PrintSmith Vision uses port 9191 for non-SSL communication and port 8443 for SSL 
communication. Depending on whether you selected Non SSL or SSL in step 6, the Installer checks 
whether the appropriate port is available.  

• If port 9191 (for non-SSL) or port 8443 (for SSL) is available, installation proceeds. Go to step 10. 

• If port 9191 (for non-SSL) or port 8443 (for SSL) is being used by another application, another port 
number is suggested. Either accept the suggested port number or enter a different unused port 
number. (If you enter an invalid port number or a number that is being used, you will be asked 
again for a port number.) 

 
Note The port number is part of the URL used to start PrintSmith Vision so if you are not using a 

default port number (9191 for non-SSL or 8443 for SSL) you will need to specify your port 
number as part of the URL. For more information about the URL used to start PrintSmith 
Vision, see “PrintSmith Vision URL” on page 40. 

10. If the Default Language Selection window opens, select your language.   

Important The language you select here affects locale settings such as the thousands and decimal 
separators and the currency used in PrintSmith Vision. 

11. In the Pre-Installation Summary window, review what is being installed. If you want to change anything 
(like the install folder), click Previous and make your corrections. Otherwise, click Install. 
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The installer now checks your system and installs any components that are required by PrintSmith 
Vision but that are not installed on your computer.  

12. When asked if you want to install i-net Designer, click Yes if you plan to add your logo to documents, 
customize the job ticket, or create custom reports. (You need i-net Designer to customize documents 
and reports.) 

Note EFI recommends that you install i-net Designer now, but you can always do so later by running 
Setup in the Applications/EFI/PrintSmith/Crystal_Clear_Installer folder. 

 
13. If you clicked Yes in the previous step, complete the installation steps for i-net Designer: 

a. Click Designer. 

 
b. Read and accept the license agreement and then click Next. 
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c. Accept the proposed installation folder (or specify a different folder) and click Next. 

 
d. Review what is being installed. If you want to change anything (like the install folder), click 

Previous and make your corrections. Otherwise, click Install. 
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e. After the installation is complete, click Done. (i-net Designer is now available in the dock.) 

 
14. The installation of the PrintSmith Vision server now continues. When asked if you want PrintSmith 

Vision to start automatically when you start the computer, click Yes or No.  

15. In the Install Complete window, click Done to re-start the computer and then click OK to confirm the re-
start. 

 
Note If you clicked Yes in step 14 above, the PrintSmith Vision Server will now be running as a service in the 

background. If you clicked No in step 14, start the server as explained “Starting and Stopping the 
PrintSmith Vision Server” on page 49. 
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Installing and Configuring an SSL Certificate 
If you selected SSL during the installation process, you must purchase, install, and configure an SSL certificate 
to make your communications secure. EFI Support will help you with the installation and configuration process. 

Note PrintSmith Vision comes with a test certificate. This certificate, however, is not valid, and will result in 
warnings when you try to start PrintSmith Vision. You must buy a valid certificate to secure your server. 

1. If you did not already do so, purchase an SSL certificate from a Certificate Authority (CA).  

Important The certificate must be compatible with Apache Tomcat v. 7. 
2. Contact EFI Support for help in installing and configuring the signed certificate that you purchased. 

Uninstalling PrintSmith Vision 
Important  If you need to uninstall PrintSmith Vision, and already activated your license, you must deactivate 

the license before you uninstall PrintSmith. If you fail to do this, you will be unable to activate the 
license on a different computer – the license will be considered “in use.” 

1. Deactivate your license as described in “Deactivating a license” on page 47. 

2. Uninstall PrintSmith by running the Uninstall PrintSmith Vision Server application. 

• On a Windows computer, the application is in the \Program Files (x86)\EFI\PrintSmith\Uninstall 
PrintSmith Vision Server folder. 

• On a Macintosh computer, the application is in the /Applications/EFI/PrintSmith/Uninstall 
PrintSmith Vision Server folder.   

3. Follow the prompts to uninstall PrintSmith. 

4. When you uninstall PrintSmith Vision on a Macintosh computer, you are warned that some shortcuts 
are not removed from the dock automatically. Remove them manually by dragging them from the dock 
into the trash. 

 
5. If you installed i-net Designer, and used a custom path, enter that path when prompted.  

Note When you uninstall PrintSmith Vision, the EFI folder is not removed. Delete this manually. 
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About Updating 
If you were already using an earlier version of PrintSmith Vision, but want to upgrade to version 3.2.1, you 
update your existing installation by running the 3.2.1 installer. You must, however, be updating from PrintSmith 
Vision 3.2, not a pre-3.2 version.  

An update requires a re-start of the computer.  

Tip For information about the enhancements and corrections made in PrintSmith Vision 3.2.1, see the 
PrintSmith Vision 3.2.1 Release Notes. (Release Notes are published for each version of PrintSmith 
Vision that is made available.) 

Important: Before You Begin the Update 

If you plan to upgrade to Windows 10 
During an upgrade to Windows 10, PrintSmith Vision is currently removed so you will lose your PrintSmith 
system unless you follow these steps: 

1. Back up your entire PrintSmith Vision system using the Backup Manager preferences as described in 
the “Backup Manager preferences” section of the PrintSmith Vision - Setup and User Guide. 

Important Store the backup on an external device or in the cloud to make sure your backed-up data 
stays safe during the upgrade. 

2. Deactivate your PrintSmith Vision license. For information about deactivating your license, see 
“Deactivating a license” on page 47. 

3. Uninstall PrintSmith Vision (see page 33). 

4. Upgrade your operating system to Windows 10. 

5. After the operating system is upgraded, install PrintSmith Vision 3.2.1 from scratch with the UPGRADE 
(not NEW USER) option and activate your license as described earlier in this guide.  

Important   Ignore the instructions on page 37 for updating your system. In this situation you are 
installing a new system and then restoring your data. 

6. Restore your system as described in the “Restoring the entire PrintSmith Vision system” section of the 
PrintSmith Vision - Setup and User Guide. 

If you plan to upgrade to Macintosh OS X 10.11 (El Capitan) 
If you are using a Mac for your PrintSmith Vision server and are interested in upgrading to OS X 10.11, note the 
following: 

• Update PrintSmith Vision to 3.2.1 before you upgrade the operating system on the Mac.  

• Custom installation folders are not currently supported for OS 10.11.  

• When Apple upgrades the operating system, it removes Java, which is required to uninstall PrintSmith 
Vision and to install future versions of PrintSmith Vision. After you upgrade the operating system, 
download and install Java (version 7).  

• When Apple upgrades the operating system, it removes your printer settings both in the operating 
system and PrintSmith Vision. After you upgrade the operating system: 

a. On the Mac, open System Preferences > Sharing, make sure Printer Sharing is selected for the 
printer, and make sure Everyone Can Print is selected under Users. 

b. In PrintSmith Vision, select Admin > Preferences > POS > Cash Drawer  and select your printer 
in the Printer field. 

Tip If you are upgrading your PrintSmith Vision server to a new Mac (not just upgrading the operating 
system on an existing Mac), see page 63. 
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If you want to use an SSL connection 
Support for SSL (htpps://) connections was introduced in PrintSmith Vision 2.3. For information about this 
feature, see page 16.  

During the update process, you will be give the choice of using a non-SSL (the default) or SSL connection. Keep 
in mind that an SSL connection: 

• Requires the purchase and installation of an SSL certificate. The certificate must be purchased from a 
Certificate Authority (CA) and be compatible with Apache Tomcat v. 7.  

• Changes the PrintSmith Vision URL: the URL begins with htpps:// and uses port 8443 by default. 

Update Your System 
Warning You must have PrintSmith Vision 3.2 installed before you can update to 3.2.1.  

1. Back up your entire system as described in the section on “Backup Manager preferences” in the 
PrintSmith Vision - Setup and User Guide. 

2. Obtain the PrintSmith Vision Server 3.2.1 installer. 

Caution Before you start the installer, close PrintSmith Vision Monitor, pgAdmin, and any PrintSmith 
Vision installation folders that are open. 

3. Start the installer the same way you did for the initial installation of the PrintSmith Vision Server. (See 
the instructions for Windows and Macintosh computers earlier in this guide.) 

4. After you accept the license agreement and read some warnings about performing backups and closing 
all PrintSmith applications, if you are given this option, select Non SSL (the default) or SSL. See “If you 
want to use an SSL connection” on page 37.  

Notes If you select SSL, you must install and configure your SSL certificate after you complete the 
update of PrintSmith Vision. For details, see  page 33. 

 If you selected SSL in a previous release of PrintSmith Vision, you will not be given the choice 
to select Non SSL or SSL. 

 
5. Follow the remaining instructions in the wizard. A re-start is required at the end of the update.  
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After the Update 
To ensure you are seeing all the latest changes to the user interface, clear your browser cache after updating 
PrintSmith Vision. You only need to do this for any browser that you used to run PrintSmith Vision in the past. 
For instructions on clearing the browser cache: 

Chrome  https://support.google.com/chrome/answer/95582?hl=en 
Firefox https://support.mozilla.org/en-US/kb/how-clear-firefox-cache 
Internet Explorer http://windows.microsoft.com/en-in/windows7/how-to-delete-your-browsing-history-in-

internet-explorer-9 
Safari https://answers.syr.edu/display/software/Clear+Cache+in+Safari+version+7+on+Mac+OSX 

Important  Make sure all your users clear their browser cache, too. 
 

 

https://support.google.com/chrome/answer/95582?hl=en
https://support.mozilla.org/en-US/kb/how-clear-firefox-cache
http://windows.microsoft.com/en-in/windows7/how-to-delete-your-browsing-history-in-internet-explorer-9
http://windows.microsoft.com/en-in/windows7/how-to-delete-your-browsing-history-in-internet-explorer-9
https://answers.syr.edu/display/software/Clear+Cache+in+Safari+version+7+on+Mac+OSX
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Important Notes About the PrintSmith Vision Server 
• Before anyone can run PrintSmith, the PrintSmith Vision server must be running. If the server is 

configured to start automatically whenever the server computer starts, no action is necessary. If, 
however, during installation you chose not to start the server automatically, you must start it manually 
(as described in “Starting and Stopping the PrintSmith Vision Server” on page 49) each time the server 
computer is re-started. 

• If PrintSmith Vision is going to be accessed from other computers (clients), the server computer must 
be configured not to go to sleep. If the server goes to sleep, users who are running PrintSmith Vision 
from other computers will get a “server down” message, and will be unable to use PrintSmith while the 
server is in sleep mode. (On a Windows computer, turn off sleep mode in the Power Options settings in 
the Control Panel; on a Macintosh, turn off sleep mode in the Energy Saver settings.) 

PrintSmith Vision URL 
You start PrintSmith Vision by entering a URL in the address bar of your browser. (For supported browsers, see 
page 11.) The format of the URL depends on whether you are running on the server computer or a client 
computer and whether you are using a non-SSL or SSL connection. 

• If you are on the server computer  

The URL for non-SSL connections is: 

http://localhost:9191/PrintSmith/PrintSmith.html 

9191 is the default port used by PrintSmith Vision for non-SSL connections. If you were asked to select 
a different port during installation, replace 9191 with the port number you specified. 

The URL for SSL connections is: 

https://localhost:8443/PrintSmith/PrintSmith.html 

8443 is the default port used by PrintSmith Vision for SSL connections. If you were asked to select a 
different port during installation, replace 8443 with the port number you specified. 

Tip On the server, you can also start PrintSmith Vision from PrintSmith Vision Monitor. When you 
installed the PrintSmith Vision Server, PrintSmith Vision Monitor was also installed. Open 
PrintSmith Vision Monitor using a shortcut on the desktop (Windows) or directly from the dock 
(Macintosh). Then click the Client Access URL to start PrintSmith Vision. 

• If you are on a client computer 

The URL for non-SSL connections is: 

http://hostname:9191/PrintSmith/PrintSmith.html 

where hostname is the name or IP address of the server computer (for example, 10.40.58.12). 9191 is 
the default port used by PrintSmith Vision for non-SSL connections. If you were asked to select a 
different port during installation, replace 9191 with the port number you specified. 

The URL for SSL connections is: 

https://hostname:8443/PrintSmith/PrintSmith.html 

where hostname is the name or IP address of the server computer (for example, 10.40.58.12). 8443 is 
the default port used by PrintSmith Vision for SSL connections. If you were asked to select a different 
port during installation, replace 8443 with the port number you specified. 

Tips For information about obtaining the IP address of the server computer, see page 41. 
 After you provide users with the URL for running PrintSmith Vision, encourage them to bookmark it. 
  

http://localhost:9191/PrintSmith/PrintSmith.html
https://localhost:8443/PrintSmith/PrintSmith.html
http://hostname:9191/PrintSmith/PrintSmith.html
https://hostname:8443/PrintSmith/PrintSmith.html
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Obtaining the IP Address of the Server Computer 
To run PrintSmith Vision from a client computer, the URL must include the IP address of the computer where the 
PrintSmith Vision server is installed. On both a Windows and Macintosh computer, you can run PrintSmith Vision 
Monitor to get the entire URL that users on client computers must provide.  

Tip When you install the PrintSmith Vision Server, PrintSmith Vision Monitor is also installed. You can open 
it using a shortcut on the desktop (Windows) or directly from the dock (Macintosh).  

1. On the server computer, start PrintSmith Vision Monitor. 

 
2. Note (or copy) the URL for client access so you can distribute it to your users.  

Tip You can click the Client Access link to start PrintSmith Vision on the server. 

Window Server 2012 and Internet Explorer 11 
If you get certain warning messages when you try to start PrintSmith Vision and are using Internet Explorer 11 on 
Windows Server 2012 R2 Standard or Essentials, you may need to change some configuration settings in Server 
Manager. 

Enhanced security configuration warning 
If you receive an “Enhanced security configuration” warning: 

1. Go to Server Manager > Local Server. 

2. Turn off IE Enhanced Security Configuration. 
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Flash Player required warning 
If you receive a warning that the Flash Player is required, you must enable the Desktop Experience on the 
server: 

1. Go to Server Manager. 

2. Select Local Server in the left pane 

3. Select Roles and Features in the right pane. 

4. Select Tasks > Add Roles and Features. 

5. Click Next until the Features list is displayed. 

6. Select the User Interfaces and Infrastructure check box. 

7. Select the Desktop Experience check box and then click Install. 

 
8. Restart the server computer.  

9. Start Internet Explorer and enter the PrintSmith Vision  URL. 
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Licensing 
The first time you use the PrintSmith Vision URL, you must activate your license before you can log in and start 
using the application. If you did not yet obtain your license, contact PrintSmith.Sales@efi.com. 

Note In some restricted environments (as determined by your organization), you must establish proxy 
settings to connect to the Internet. You will have the opportunity to establish proxy settings while 
activating your license. 

If you later purchase additional features, you will need to update your license as described on page 47. 

If you decide to move the PrintSmith Vision server to another computer, you must deactivate the license before 
you uninstall PrintSmith Vision. See “Deactivating a license” on page 47. 

Activating your license 
1. Enter the PrintSmith Vision URL in the address bar of your browser as explained in “PrintSmith Vision 

URL” on page 40. 

2. If you get a message that Adobe Flash Player needs to be installed, click the link to download the player 
and then install it. 

 
3. After you install the player, restart the browser and enter the PrintSmith Vision URL again. 

  

mailto:PrintSmith.Sales@efi.com
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4. Click Activate License. 

 
5. The Manage PrintSmith Options page opens and summarizes the terms of the license activation. Click 

Continue. 
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6. In some restricted environments (as determined by your organization), you must establish proxy 
settings to connect to the Internet. If this is the case, do the following (otherwise, proceed to step 7). 

a. Click Setup Proxy. 

 
b. If necessary, contact your IT staff to obtain the information you need to configure proxy settings 

(address and port). 

c.  Enter the Address and Port (and Username and Password if necessary), and then click Apply. 
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7. Enter your license activation code and click Continue. 

 
8. After you get the confirmation of your license activate, click Finish. 

 
9. Refresh the PrintSmith Vision page (in your browser) so you can log into the application. 

If you experience problems with licensing 
If, after your license is successfully activated, you experience any problems, use PrintSmith Vision Monitor on 
the PrintSmith Vision server to re-start the license server. 

1. Start PrintSmith Vision Monitor: 

• On a Windows computer, start PrintSmith Vision Monitor using the shortcut on the desktop. 

• On a Macintosh computer, start PrintSmith Vision Monitor from the dock. 

2. Click Restart License Server. 
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Note On a Macintosh, if re-starting the license server does not solve the problem, re-start the 
computer. 

 

Updating your license after you purchase additional features 
If you initially purchase the base PrintSmith Vision system, but then decide to purchase additional features (for 
example, integrated credit card processing or Tracker), contact PrintSmith.Sales@efi.com and request the 
additional features you want. You will then need to update your license before you can use the features you 
purchased. 

1. After you receive a confirmation e-mail from PrintSmith Sales, log into PrintSmith Vision. 

2. Select Help > About PrintSmith. 

3. Click Update License. 

4. Click Update to activate the additional features you purchased. 

5. Log out of PrintSmith Vision and log in again to see the newly activated features. 

Deactivating a license 
If for any reason you need to uninstall PrintSmith Vision, perhaps to move it to another computer, you must 
deactivate the license before uninstalling PrintSmith Vision. Likewise, if you stop using an individually licensed 
feature, you must deactivate it. 

Important  If you do not deactivate your license before you uninstall PrintSmith Vision, you will not be able to 
activate the license on a different computer – the license will be considered “in use. 

1. Before you uninstall PrintSmith Vision, log into the system. 

2. Select Help > About PrintSmith. 

  

mailto:PrintSmith.Sales@efi.com
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3. Click Update License. 

 
3. Click Deactivate All. (If you are deactivating individual features, click Deactivate next to the feature.) 

 
4. After the deactivation is confirmed, click Finish. 

5. To uninstall PrintSmith Vision, follow the instructions in “Uninstalling PrintSmith Vision” on page 33. 
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Logging Into PrintSmith Vision 
After your license is entered and validated, you can run PrintSmith Vision.  

1. Enter the PrintSmith Vision URL in your browser. 

2. In the login window, use admin/admin to log in as the administrator. 

Notes For security reasons, EFI strongly recommends you change the admin password. 
 If you are upgrading to PrintSmith Vision from PrintSmith 8.1, the system user name and password that 

you used with PrintSmith 8.1 will not work with PrintSmith Vision.    

Starting and Stopping the PrintSmith Vision Server 
The PrintSmith Vision server runs as a service in the background (so is not visible). When you run PrintSmith 
Vision, you access the server from a browser. If the server is not running, you cannot run PrintSmith Vision. 

If (during the installation process) you did not configure the server to start running automatically whenever the 
server computer is re-started, you must start the PrintSmith server manually. 

If you need to make PrintSmith Vision unavailable to your users, you can stop the server and then re-start it. You 
use PrintSmith Vision Monitor to stop and start the server. (As described earlier, when you install the PrintSmith 
Vision Server, PrintSmith Vision Monitor is also installed.) 

If (during the installation process) you did not configure the server to start running automatically whenever the 
server computer is started, you can use PrintSmith Vision Monitor to configure the server to start automatically. 

Start or stop the server 

1. Start PrintSmith Vision Monitor: 

• On a Windows computer, start PrintSmith Vision Monitor using the shortcut on the desktop. 

• On a Macintosh computer, start PrintSmith Vision Monitor from the dock. 

 
2. If the server is not running, click Start Server. (In the figure above the server is running.) 
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3. To stop the server, click Stop Server. 

4. Close PrintSmith Vision Monitor. 

Ensure the server runs automatically 

If (during the installation process) you did not configure the server to start running automatically whenever the 
server computer is started, you can use PrintSmith Vision Monitor to configure the server to start automatically. 

1. Start PrintSmith Vision Monitor: 

• On a Windows computer, start PrintSmith Vision Monitor using the shortcut on the desktop. 

• On a Macintosh computer, start PrintSmith Vision Monitor from the dock. 

2. Click the Preferences tab. 

 
3. Select the Start PrintSmith Vision Server when computer starts check box. 

4. Unless advised to change these by EFI Customer Support, ignore the remaining fields. For example, 
you may be advised to change the Postgres port as described in “Appendix B: Changing the Postgres 
Port” on page 61. 

5. Close PrintSmith Vision Monitor. 

Tip For more information about using PrintSmith Vision Monitor, see the PrintSmith Vision - Setup and User 
Guide. 
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Upgrade Checklist 
If you were using PrintSmith Classic 8.1, you can upgrade to PrintSmith Vision and import your data (pricing, 
preferences, accounts, invoices and estimates, and so on) from PrintSmith 8.1.  

Important The instructions in this upgrade chapter apply to all PrintSmith users, but PrintSmith Site and 
Digital StoreFront users have some additional requirements to complete the upgrade and 
integration. Review the upgrade section of the PrintSmith Vision - PrintSmith Site Integration Guide 
or the PrintSmith Vision - Digital StoreFront Integration Guide before you start the upgrade 
process.  

To ensure a successful upgrade, as you go through the procedures, use this checklist to make sure you 
complete all the steps.  

  Are you using line item taxation? If you are, do not upgrade at this time. Line item taxation will be 
supported in PrintSmith Vision in a later release. 

  Do you meet the PrintSmith Vision system requirements? (See page 10.) 

  Did you obtain your PrintSmith Vision license? 

  Did you install PrintSmith Vision and select the UPGRADE option? (See “Installing the PrintSmith Vision 
Server” starting on page 15). 

  Have you activated your license? (See page 43.) 

  Is PrintSmith 8.1.28 installed? 

  Did you post all POS charges (select AR > Post POS Charges and click OK)? 

  Did you perform daily and monthly closeouts? 

  Do you use PrintSmith Site?  

�  Did you contact EFI Support to coordinate your upgrade? 

�  Did you zip up your Images folder? 

  Do you use Tracker? 

�  Did you pause or complete active items? 

�  Are all employees clocked out? 

  Did you obtain and enter your export activation key? 

  Did you export your data from PrintSmith 8.1.28? (See page 53.) 

  If you use PrintSmith Site, did you copy your Images.zip file to the Preferences folder (in the PrintSmith 
folder) so it is with all your exported data? 

  Did you review the import exceptions? (See page 56.) 

  Did you use PrintSmith Vision to import your data? (See page 56.) 

  Did you re-start the server after the import? 

  Did you check the imported data? (See page 57.) 

  Are you planning to customize documents or reports (e.g., add a logo to invoices)? If so, did you install 
i-net Designer when you installed PrintSmith Vision? (See steps 13-14 of the Windows server 
installation process or steps 12-13 of the Mac server installation process.)  
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Export Your Data from PrintSmith 8.1 

Before you export data 
Before you export data from PrintSmith 8.1.28, certain conditions must be met. In particular, your system must 
be in a stable and “clean” accounting state. 

Important Be sure to export data from PrintSmith 8.1.28, not an earlier version.  
1. Post all POS transactions: select AR > Post POS Charges and click OK.  

2. Perform both a daily and monthly closeout. (The register tape should be blank.) 

Tip You do not have to wait until the end of a month to do a monthly closeout as long as you have 
done a daily closeout. 

3. Templates cannot be imported into PrintSmith Vision. If you have document templates that you want to 
use in PrintSmith Vision, copy them to estimates/invoices. In PrintSmith Vision you can then turn them 
back into templates. 

If you are using the unsupported size table (ID 5) 
You will be prevented from exporting data from PrintSmith Classic if you are using the unsupported size table (ID 
5) and specifying it in Admin > Preferences > Estimator > Stock and Sizes. You should (a) re-enter your sizes 
in the appropriate size table (as explained below) and then (b) select this size table in Admin > Preferences > 
Estimator > Stock and Sizes before trying to export again.  

For PrintSmith Vision to import the sizes correctly, the data must be entered in the right table in Classic:  

• If the unsupported size table is in US inches, use Table Editor to enter the data in the size table with 
table ID 1. Sizes in table ID 1 in Classic are imported as US Imperial IN in PrintSmith Vision. 

• If the unsupported size table is in millimeters, use Table Editor to enter the data in the size table with 
table ID 2. Sizes in the table ID 2 in Classic are imported as Metric MM in PrintSmith Vision. 

• If the unsupported size table is in centimeters, use Table Editor to enter the data in the size table with 
table ID 3. Sizes in the table ID 3 in Classic are imported as Metric CM in PrintSmith Vision. 

• If the unsupported size table is in metric inches, use Table Editor to enter the data in the size table with 
table ID 4. The sizes in table ID 4 in Classic are imported as Metric M-IN in PrintSmith Vision. 

Notes To figure out the ID of a size table in PrintSmith Classic, use Table Editor to open the table and click 
Properties. The ID will be displayed. (The table ID controls how Vision imports the sizes.) 

 Make sure the size table in which you are re-entering the data does not include any duplicate size 
names. You may want to delete all the sizes in the table before re-entering the ones from the 
unsupported table. 

After entering your sizes in the correct table, be sure to specify this table with Admin > Preferences > 
Estimator > Stock and Sizes before starting the export from PrintSmith Classic. 

If you use PrintSmith Site 
Important The instructions in this upgrade chapter apply to all PrintSmith users, but PrintSmith Site users 

have some additional requirements. Review the upgrade section of the PrintSmith Vision - 
PrintSmith Site Integration Guide before you start the upgrade process. The timing of your upgrade 
is important. 

If you were using PrintSmith Site with PrintSmith 8.1, do the following: 

 1. Contact EFI PrintSmith Support about coordinating the upgrade process. (Support must change a 
setting for your site just before you export your data.) This is a critical step. 

2. To ensure that your graphics (images) are imported into PrintSmith Vision: 

a. Zip up the contents of the entire PrintSmith Images folder (PrintSmith\E-Commerce\Images). 

b. After you export your data from PrintSmith (see page 54), copy the Images.zip file to the 
Preferences folder (where your data was exported). 

Note  If you fail to perform step 2, you will need to re-import your data. 
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If you use Tracker 
If you were using Tracker in PrintSmith 8.1, before you export data, make sure:  

• There are no active items in the Tracker Console. Active items will not be imported into PrintSmith 
Vision. Make sure all items are completed, or pause any active items if you do not want to wait for them 
to complete. (You will be prevented from exporting data if there are active items.)  

• All employees are clocked out (not just on break).  

Note If your employees use a PIN to log into the Tracker Console, you will need to re-create the PINs in 
PrintSmith Vision. PINs are not imported. 

For information about using Tracker in PrintSmith Vision, see the PrintSmith Vision - Tracker User Guide. 

If you use Scheduler 
If you were using Scheduler in PrintSmith 8.1, keep in mind that scheduled jobs are not imported. Try to time the 
upgrade when you have as few jobs on the schedule as possible, because you will have to re-schedule them in 
PrintSmith Vision Scheduler.  

For information about setting up and using Scheduler in PrintSmith Vision, see the PrintSmith Vision - Scheduler 
User Guide. 

If you use Digital StoreFront 
If you were using Digital StoreFront in PrintSmith 8.1, be sure to review and follow the upgrade steps in the 
PrintSmith Vision - Digital StoreFront Integration Guide. In particular: 

• If Digital StoreFront is self-hosted, make sure you have version 8.4 (or higher) installed. 

• Complete all the upgrade and integration steps in a timely fashion to minimize the time web orders are 
waiting in a queue. 

Export procedure 
If you are licensed to upgrade to PrintSmith Vision, you are given an activation key so you can export your data 
from PrintSmith 8.1. Again, be sure you have version 8.1.27 installed. 

Notes A typical export takes 1-2 hours. 
 If you are a PrintSmith Site user, do not begin the export if you did not yet contact EFI PrintSmith 

Support about switching over to PrintSmith Vision. 

To export data 
1. Obtain an export activation key from EFI. 

2. Enter your activation key: 

a. Start PrintSmith 8.1. 

b. Select Admin > Preferences > System > Product Activation. 

c. Enter your key in the Activate Full Export Capabilities field and click OK. 

d. Close the Preferences window.  
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3. Export your data: 

a. Select Admin > Preferences again. 

b. Click Migrate Data under System. (Migrate Data is available only if you entered a valid export 
activation key in step 2c.) 

c. (Required) Click Export Preferences, Export Table Files, Auto Cost All Pending Invoices, and 
Export ALL Data Files. (You will be informed that the data is being exported to the Preferences 
folder in your PrintSmith folder.) 

 
4. If you use PrintSmith Site, copy your Images.zip file to the Preferences folder (in the PrintSmith folder) 

so it is with all your exported data. 

Install PrintSmith Vision 
1. Install PrintSmith Vision as explained in “Installing the PrintSmith Vision Server” starting on page 15. Be 

sure to select the UPGRADE option since you will be importing your own data. 

 
2. Review the information about the PrintSmith Vision server and the URL used to start PrintSmith Vision. 

See “Running PrintSmith Vision” starting on page 39. 

3. Activate your license as described on page 43. 
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Import Your Data to PrintSmith Vision 
Once your data is exported from PrintSmith 8.1, you can import it to PrintSmith Vision. When you import data, 
you can control how many months of estimates/invoices you want to import.  

Warning If you indicated during the installation process that you are importing data, you cannot start to enter 
new data (like customer accounts) until after you import your data.  

Import exceptions 
Your data will be imported with these known exceptions: 

• If you limit the number of months of data you want to import, but have items with negative balances that 
were charged to post payments and that precede the time period you specified, those items will not be 
imported. 

• If you have large format digital definitions, the values in the Maximum Width and Minimum Width 
fields are not imported. You will need to re-enter those values. 

• PrintSmith Vision does not include a default waste chart. If any of your press definitions used the default 
waste chart, you must create a new waste chart and assign it to those definitions. 

• If an account was deleted in PrintSmith, any invoices associated with that account are imported without 
an account specified for them. 

• Templates are not imported. If you copied the templates to documents (as recommended in step 5 
under “Before you export data” on page 53), you can re-create the templates from these documents. 

• Cost Plus is not a supported pricing method for digital (copier) definitions in PrintSmith Vision. You must 
edit any digital definitions that used Cost Plus: select a different method and set an appropriate rate. If 
this new rate results in different pricing, and an old document is opened, a price update warning 
message will be displayed.  

• Sometimes bad data will cause a tax element to be duplicated in the sales tax table, resulting in an 
incorrect effective tax rate. If you notice this when going through the post-import checklist, select 
Pricing > Sales Tax, select your default tax table, correct it, and click Save. 

• If you use Tracker, employee PINs are not imported. You must use Employee Manager in PrintSmith 
Vision to set up new PINs. 

• If you use Scheduler: 

• Shifts are not imported because they are defined differently in PrintSmith Vision Scheduler. 

• Jobs currently on the schedule are not imported; you will need to re-schedule them in PrintSmith 
Vision Scheduler.  

• If you use PrintSmith Site, and any catalog names included double quotes (“), these were changed to 
single quotes (‘) to ensure a successful import. 

Import procedure 
Warning An import can take up to 48 hours. EFI recommends that you start the process at EOB on a Friday.  

1. If necessary, move your exported data to a folder that you can access when running PrintSmith Vision. 

2. Start PrintSmith Vision: 

a. Open your browser on the server computer. 

b. Start PrintSmith Vision by entering this URL in the address bar: 

For non-SSL connections 

http://localhost:9191/PrintSmith/PrintSmith.html 

Note If you specified a different port during installation because port 9191 was already in use, 
replace 9191 in the URL with your port number.  

  

http://localhost:9191/PrintSmith/PrintSmith.html
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For SSL connections 

https://localhost:8443/PrintSmith/PrintSmith.html 

Notes If you specified a different port during installation because port 8443 was already in use, 
replace 8443 in the URL with your port number. 

 If this is the first time you are running PrintSmith Vision, you will need to activate your 
license (as described on page 43) before you can log in.  

c. Log in as admin/admin. (Be sure to change the password as soon as possible – using Admin > 
Change Password – to prevent unauthorized users from using the admin password and gaining 
full access to PrintSmith.) 

3. In PrintSmith Vision, select Admin > System Monitor. 

4. Click Import. 

 
5. To limit the invoices and estimates that are imported to those created in the last x months, enter this 

number in the months field. (If the field is blank, all invoices and estimates are imported.) 

6. Click Import Data, navigate to the folder that has all your exported data, and select all the files in the 
folder. (Click the first file in the list, press and hold Shift, and click the last file in the list.) 

7. After the import is done, click Import Statistics to see if any errors were reported. 

8. Re-start the server (see below) and check the data that was imported into PrintSmith Vision as 
described below. 

Important Once your data is imported into PrintSmith Vision, make sure your PrintSmith 8.1 system is no 
longer being used for business purposes, for example, to create estimates or invoices. 

  EFI recommends that you keep the data you exported from PrintSmith Classic  just in case you 
need to re-import it.  

Re-start the PrintSmith Vision server 
After you import your data, re-start the PrintSmith Vision server. For information about doing this, see “Starting 
and Stopping the PrintSmith Vision Server” on page 49.  

Check the Imported Data 
Before you start using PrintSmith Vision to run your business, you should check the data that was imported using 
the checklist on page 58. Occasionally, some bad data in your PrintSmith 8.1 system may cause problems in 
PrintSmith Vision. There are also a few exceptions to what is imported as described on page 56. Be sure to 
review those exceptions. 

https://localhost:8443/PrintSmith/PrintSmith.html
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If you find a minor issue, for example, one incorrect record or some missing data in a field, make the corrections 
yourself. If you find a more pervasive problem – an issue that affects multiple records – contact PrintSmith 
Support. 

Note Sometimes if a piece of data is wrong or missing, Vision corrects it during the import, for example, adds 
a generic color to a stock definition. In this case, when you open the definition for the first time in Vision 
and then try to close it (or try to view another definition), you will be prompted to save the definition even 
if you did not make any changes. Save the definition to avoid further prompts in the future.  

Post-import checklist 
Below is a checklist of areas to examine after your data is imported. 

  Preferences Check them all to make sure your settings are the way you want. 

  Tables Use Table Editor to check the contents of tables that you use. 
 Notes   The size tables in PrintSmith were replaced by the Dimension table in 

PrintSmith Vision.  
              For important information about the Basic Sizes table, see below. 

  Charge definitions Check a few for each pricing method (e.g., job aware, markup, flat rate, 
always ask, etc.). 

  Press definitions Check a few sheet-fed definitions and a few roll-fed (if you have web presses) 
and review target pricing (if any). 

  Digital definitions Check a few color, B&W, and large format definitions. 

  Stock definitions Check a few definitions for different types of stock (e.g., sheet, envelope, roll, 
etc.). 

  Accounts Check a few customer and prospect accounts (all tabs). 

  Contacts Check a few contact accounts (all tabs). 

  Sales tax Check your tax tables, including tax elements and effective tax rate.  

  Security Check your security setup and verify a few user definitions. 

  List price schedules If using, open and review. 

  Stamp schedule If using, open and review. 

  Documents Open a few invoices and estimates and review their contents (including 
different types of jobs). 

  Payments Verify cash drawer status; verify AR balances; and verify account status, 
payments, and balance in the Post Payments window. 

  Delivery tickets Use Delivery Ticket Manager to review your delivery ticket. 

Basic Sizes table 
To preserve data integrity, the standard basic sizes (in the Basics Sizes table) in PrintSmith Vision are fixed and 
cannot be changed. If you made any changes to the Basic Sizes table in PrintSmith Classic, note the following: 

• If you edited the basic sizes with ID 1 – 11, your changes will not be imported to PrintSmith Vision; 
stocks using the edited basic sizes will use the standard sizes instead. Review your stock definitions to 
make sure they are still correct. 

• If you added basic sizes in Classic (beyond those with ID 1 – 11), these basic sizes will not be imported. 
Any stocks that use a basic size you added will have a blank basic size after the import. Again, you 
must review your stock definitions. 

• If either of the above cases applies to you, the stock weight calculation on jobs will be affected until you 
correct the stock definitions. 
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Appendix A: Accessing the Database 
The PrintSmith Vision database is a Postgres SQL database, and resides on the computer where you installed 
the PrintSmith Vision server. 

Note For information about performing and restoring backups, see the PrintSmith Vision - Setup and User 
Guide. 

If you want to examine the structure of the database, for example, because you are writing custom reports, you 
must use the Postgres pgAdmin III utility. 

• On a Windows computer, a Postgres shortcut was added to the desktop when you installed the 
PrintSmith Vision server.  

• On a Macintosh computer, Postgres was added to the dock when you installed the PrintSmith Vision 
server. 

Caution  Never edit information in the database directly and never change the structure of the database tables. 
Either action would compromise the integrity of the database severely. 

If no server is listed in pgAdmin III 
If you run pgAdmin III on the PrintSmith Vision server computer, and no database server is listed, you must add 
the server as described below. The server exists; it is just not “visible” in pgAdmin III. Adding the server is a one-
time procedure. 

1. On the computer where the PrintSmith Vision server is installed, double-click the Postgres shortcut on 
the desktop (Windows) or click Postgres in the dock (Macintosh). The pgAdmin III window opens. 

3. Select File > Add Server. The New Server Registration window opens. 

 
 

4. In the Name field, enter a name for the server (it can be anything you want). 

5. In the Host field, enter localhost. 
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6. Unless you changed the port, leave Port set to 5432. 

7. Leave the following set as they are: 

• Service = blank 

• Maintenance DB = postgres 

• Username = postgres 

8. In the Password field, enter PrintSmith^2012. 

9. Ignore the remaining fields and click OK. 

The server is now listed.  

Displaying the contents of the database in pgAdmin III 
When you start pgAdmin III, the PrintSmith server may have a red X next to it. (This not a sign of any problem.)   

 
1. Double-click PrintSmith (localhost:xxxx). 

 
2. Expand Databases. 

3. If printsmith_db database has a red X next to it, double-click it. (As long as the red X is displayed, you 
cannot look at the structure of the database.) 
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Appendix B: Changing the Postgres Port 
Communication between PrintSmith Vision and the Postgres database takes place through a port. When you 
install PrintSmith Vision, a default port number is used. In some cases that port may already be in use, which will 
prevent PrintSmith Vision from running. In this situation you must change the Postgres port number as described 
below. Only do this if advised by EFI Customer Support. 

1. Make sure the Postgres pgAdmin III utility is not running. 

2. On the server computer, start PrintSmith Vision Monitor. You can open it using a shortcut on the 
desktop (Windows) or directly from the dock (Macintosh). 

3. Click the Preferences tab. 

 
4. Enter an unused port number in the Postgres Port field. 

5. Click Stop Server and Apply. 

6. Click the Server tab in PrintSmith Vision Monitor and click Start Server. 

7. Add the same port number in pgAdmin III: 

a. Double-click the Postgres shortcut on the desktop (Windows) or click Postgres in the dock 
(Macintosh). The pgAdmin III window opens. 

b. Select File > Add Server. The New Server Registration window opens. 

c. In the Name field, enter a name of your choice. 

d. In the Host field, enter losthost. 

e. In the Port field, enter the same port number you entered in PrintSmith Vision Monitor (step 4 
above). 

f. In the Password field, enter PrintSmith^2012. 

g. Leave the remaining fields as they are and click OK. 

Enter new 
port number 
here. 
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Appendix C: If You Upgrade Your Server Hardware 
If you were using PrintSmith Vision, and at some point decide to upgrade your server, for example, you get a 
more powerful Windows or Macintosh computer, you will need to do the following: 

1. Back up your entire system as described in the “Backup Manager preferences” section of the PrintSmith 
Vision - Setup and User Guide. 

2. De-active your license on the current PrintSmith Vision server. (See page 47.) 

Note If you fail to de-activate your license it will still be considered “in use,” and you will be unable to 
activate it on the new computer. 

3. Uninstall PrintSmith Vision from the old server. (See page 33.) 

Note On newer Macs (starting with OS X 10.9), Java is no longer installed. The PrintSmith Vision 
Installer requires Java so you will need to download and install Java version 7. (The Installer 
will warn you if Java is not installed.) 

4. Install PrintSmith Vision on the new computer with the UPGRADE (not NEW USER) option and re-
activate your license. 

5. Restore your PrintSmith Vision data on the new computer as described in the “Restoring the entire 
PrintSmith Vision system” section of the PrintSmith Vision - Setup and User Guide. 
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